New Features for PSCALE Versions 2.8 and Higher

This help file is named 28ANDUP.WRI and is located in your \PSCALE directory.

GENERAL TOPICS: Versions 2.8 - 3.7

New Features within graphics mode   	(2.8 Dos & Windows Versions)
Inharmonicity Graph Styles          	(2.9 Dos & Windows Versions)
Send Scales via EMAIL               	(2.9 Windows Version)
Pscale Uninstall Set-Up and Use	(2.9 Windows Version)
Addl. Features within graphics mode	(3.0 Dos & Windows Versions see below)
Compare Scales - Graphs & Text	(3.0 Dos(limited) & Windows Versions see below)
100% Windows Pscale Graphing 	(3.1 Windows Version)
Switch Scales from Graphics Screen	(3.2 Windows Version)
Add Plain Wire Hitch Loop Info	(3.2 Windows Version - data embedded in scale file)
Display Section (plate) Breaks	(3.2 Windows Version - data embedded in scale file)
Plot Core /Plain Data in Edit Mode	(3.2 Windows Version - data embedded in scale file)
Add 60 char MFG, Model, #		(3.2 Windows Version - data embedded in scale file)
Added top Uni, bottom Bi, top Bi, bottom Tri tensions	(3.4 Windows Version )
Vista 32 bit compatibility Upgrade	(3.5 Windows Version)
Added Sectional Tension Report, Addl. Tension graph, etc.	(3.6 Windows Version)
Added Edit Wrap Constants (Set Up menu) (3.7 Windows Version)
Version Number anomaly corrected  (3.7 Windows Version)
Change Pitch anomaly Corrected  (3.7 Windows Version)
Back Door to view all Data   (3.7 Windows Version)

Note: During the past several years I have concluded that it is better to take a good bass string rubbing/pattern and supply this along with your desired wire sizes to the string maker. You can mark desired exposed core on the rubbing if necessary.This reduces chances for measurement errors. The time to make a rubbing is probably the same as measuring and entering "tail" data into Pscale.

Note: All Win version 3.1 - 3.4 info is contained in WINGEDIT.TXT which invoked by clicking the Help button of the Graphics / Win screen (accessed from the Edit Scale Data spreadsheet screen).

Pscale Printing Issues: Windows 95 and 98 have been departing from MS-DOS printer support. Many new printers do not even include DOS printer drivers. Some Pscale for Windows printing routines use DOS Printer Services and may not work in Win 95 and 98. You will have to use the View option which prints to a file and runs Windows Notepad for viewing and printing. Also, you may encounter this printing problem if running PSCALE for DOS or MSCALE for DOS. For the MS-Dos die hards, All PSCALE for DOS Ver 3.2 print routines now capture print data to a file named DPRINT.TXT, DBPRINT.TXT, and DTPRINT.TXT which may be opened using Windows Notepad or Wordpad (Pscale File, Windows Program, notepad dprint.txt).

PLEASE SEND ORIGINAL SCALE DATA - Different scales help me realize needed additions.

NEW FEATURES WITHIN GRAPHICS MODE:	(2.8) MS DOS Version

F5 in graphics mode opens a help window for quick review
Alt E Set ATWM/BTWM within graphics mode
Alt B (Bump) Plain/Core increase or Decrease within graphics mode
Alt T Get Total/Target tension within graphics mode
Pressing 1 - 8 will go notes 10 - 80 (5=50) within graphics mode
Maximum Bass Target Tension Values have been increased. You may
exceed the default tension lines. Max values = UNI-390lbs BI-330lbs TRI-300lbs (Dos ver. only)

INHARMONICITY GRAPH STYLES:         (2.9)

The Edit Menu Contains 2 new items.

Assign Graph Styles:
    
Assign Graph Styles allow you to select different inharmonicity curves for your scale files. When you create and enter a new scale file the default curves are used. The default curves are good formost pianos up to about 7'. 9' concert grands require a different curve and this option (choice 3) allows you to apply a 9' concert grand curve. You are given 4 choices:
1   Default         good for most pianos up to 7'
2   Lower Bass      may be helpful for some 7' - 9'
3   9' Concert      9'concert grand curves
4   List Files      Select files from Curve Filenames

Edit/Add Graph Styles: (Dos Version Only)

This option allows you to edit the inharmonicity curves contained in the .BNK files or create copies of the .BNK to modify to your scale preferences. Please do not modify NEWSCALE.BNK file as it is used as a template for all new scale files. Use the create option to create a new file with a filename of your choice. Please note that any changes to these .BNK files are permanent so edit at your own risk. You will be able to get the .BNK files off the the distibution disks if you do make changes that you do not like.

Suppress Lengths In Bass Info Printout when using String Rubbings:   (2.9)

When printing a Bass Info string winding report a 3rd option has been added:
(D)ata Only or (W)/Rub
(D)ata Only (default) means that you have included tail information and the string winding printout will include length of tail, length of wrap, and length of tail and wrap.
(W)/Rub means that you are including a Bass String Rubbing with your data sheet for the string winder. In this case the printout will not include any length measurements and detail only wire
diameters.

Send Scales via EMAIL :              	(2.9 Windows Version)

The Help File for this feature is named EMAIL.WRI and may be
accessed from the Pscale for Windows Help Menu.

Pscale Uninstall Setup and Use: 	(2.9 Windows Version)

A Pscale Uninstall Set-Up Icon has been added to the Pscale Program Group. Note: If you are
downloading updates you will need to click Add Icons in the Pscale for Windows main menu
Help.

The Pscale Uninstall Set-Up, when run, will not remove any files. It only generates files that are used to uninstall Pscale by the install program or invoked manually by a DOS command.

Starting with the Version 2.9 distribution disks, I have a new Windows Install program that installs the Pscale Programs and files on your system. This new Install program has a Remove Button
for uninstalling Pscale. When you install a newer version of Pscale it is preferable to uninstall the current version before installing the newer version or you will have to answer about 85 Overwrite this file? prompts. There is also a batch file that may be run from DOS named PSREMOVE.BAT

When uninstalling / reinstalling the key issue is not to loose or overwite any scale data files. I have included the Pscale Uninstall Set-Up Icon to help prevent this from happening. Pscale Uninstall Set-Up allows you view all files in the uninstall list and unmark any files listed for removal. Note: Each time Uninstall Set-Up is run it marks all sample scale filenames for removal. Uninstall Set-UP then re-generates two uninstall files. UNINSTAL.TXT (used by the windows install program) and PSREMOVE.BAT (may be run from DOS). 

The only way you could loose a scale file is if you erased one or all of the sample scale files that are distributed with Pscale and then created or renamed a scale file with a name that is the same as one of the pscale sample scale files. Sample filenames are listed at the end of the getting started document. 

In versions 2.8 and higher (Windows and Dos) There is one other data sensitive file name: SCALEDIR.LST (SCALEDIR.TXT is a text backup) which is used to store the scale file manager scale file names and the Info that you include in the Info column. If you are re-installing you should not overwrite SCALDIR.LST. If you should happen to by mistake, SCALEDIR.TXT should have most of the Info column information.

Of course, if you back up your scale files (.DBF) to diskette you are further assured that you will never lose data.

PSCALE Version 3.0

Program Fixes:

Loudness Sustain now ploting correctly (had been using Cu factor .89 regardless of wrap type)
	My apologies for this oversight!
Windows version now behaves correctly when moving to or from note 1 of the scale data grid
Setup - Printer (dos ver) now highlights your current printer instead of losing the current setting
Graphics/Dos mode of the win version now allows 100 lbs. > greater target tensions for concert grands. 
Max values = UNI-390lbs BI-330lbs TRI-300lbs 


Addl. Features within graphics mode	(3.0 Dos & Windows Versions)

You can now define a note range for the following functions. This greatly improves your options. For example: You have just hand tweaked 4 bass notes on the tenor bridge. Now you want to boost the tension on notes 1 - 26 without changing 27 - 30.

Specify note range in F2 - Autoscale or Calc all wraps ie. 1-13 or 14-26 or 27-30 (F2 = Dos version command)	
Specify note range in Alt E (ends - change ATWM BTWM)  (Alt E = Dos version command)
Specify note range in Alt B (bump core size up or down)  (Alt B = Dos version command)
Save all graphs to .PCX file format (except the actual edit in graphics screen)

Compare Scales - Graphs & Text	(3.0 Dos(limited) & Windows Versions)

You can now compare 2 different Scale files at the same time:

This can be very helpful and also interesting. You can see the before and after scales on the same screen or printout. You can plot the speaking lengths of a chickering 9' and a steinway 9' and see that they are almost exactly the same. You can see before and after loudness/sustain on the same screen. You can print out side by side speaking length text data if you have adjusted the speaking lengths and are installing new bridges or bridge caps.

Compare two scales has been added for the following:

	Text printout of almost all fields
	Graphs of TEN & INH and LOUDNESS/SUSTAIN
	Graphs of the following fields: SPLM,DIAM,INH,TEN,BP

I have included 3 original 9' concert grand scales in this update to compare. They are named:
C9O$.DBF	S9O$.DBF	B9O$.DBF    ($ should prevent overwrite of any of your scales)
Chickering	Steinway	Baldwin	        (try C9O$ with S9O$ for SPLM)

Using Compare

Compare in Pscale for Windows:

Compare is accessed from the File menu Open command (file manager).You will see the Compare Button in the upper right portion of the file manager screen.You are prompted to select the first scale file and then the second scale file. The compare window opens and you are presented with several Button Options. Ten/Inharmonicity and Loud/Sustain Buttons will plot the graphs. Text Compare and Graph Compare buttons require that you click the Select Field Button. Change Scales allows you to select a new set of scale files to compare.

Compare in Pscale for DOS:

My apologies to Dos users but Compare has only a limited inclusion. This is in part because Pscale for DOS will still run on almost any IBM PC with 512 RAM and I would prefer not to have to maintain different versions of the DOS version.

The DOS compare is limited to graphs only. No text data can be generated. You can view or print all of the same graphs as the windows version. Enter the following at the DOS prompt

CD\PSCALE			<ENTER>	(CHANGE TO PSCALE DIRECTORY)
C:\PSCALE>WSCALE		<ENTER>	(GENERATE SCOMPARE.BAT)
C:\PSCALE>SCOMPARE	<ENTER>	(DISPLAY COMMAND LINE MENU)

Examples of SCOMPARE commands:

SCOMPARE  [VIEW]  [TEN/INH]  [VOSE57]  [VOSE57O]  
C:\PSCALE>SCOMPARE V 20 VOSE57 VOSE57O	<ENTER>

SCOMPARE  [SAVE TO .PCX]  [SPLM]  [VOSE57]  [VOSE57O]
C:\PSCALE>SCOMPARE X 1 VOSE57 VOSE57O	<ENTER>

PSCALE Version 3.1 - 3.3 (Windows Version Improvements)

Versions 3.1 to 3.3 adds additional program fixes as well as the ability to "sculpt" Tension lines in the bass section using the "Options" button within the Autoscale routine. See Version 3.6 notes below.

PSCALE Version 3.4 (Windows Version Improvements)

Version 3.4 adds additional program fixes. In addition, the following features have been added:

A note label (like C#4) has been added to all notes while working within the Graphics/Win edit screen.
Additional Tension information is available while within the Graphics/Win edit screen.
Program Delivery has been Streamlined / Changed from 3.5 in. diskette to CD format.

Note: Starting with Pscale version 3.4, most installations will be deliverd via CD format. This installation will install a version of Pscale "branded" as UNREGISTERED EVALUATION COPY when Pscale starts. All users will be provided with a small additional installation file (via email or shipped) named PSCALEID.EXE. When this file is run, the "branding" will be removed and the registered user name will appear in the initial Pscale splash screen.

Added top Uni, bottom Bi, top Bi, bottom Tri tensions : In the Graphics / Win screen, the Tension button now lists the changeover total tensions (Tension Jump) at these sectional transition points. The Pscale graphs give tension and inharmonicity for a single string. These change over values are the combined tensions between Unichord, bichords, and trichords.

Pscale Version 3.5 (Windows Version Improvements)

Pscale 3.5 Win is a Windows Vista32 bit compatible version. Version 3.4 ran fine in Vista with the exception of the Graph Compare and Graphics / Dos (rarely used) routines. I found a few other minor adjustments that were also beneficial. If you are running version 3.5 on a Windows Vista machine you should pull down the Setup menu and click the Graphics Win/Dos option. Answer (Y)es to the top question and hit the enter Key. You can ignore the remaining questions.
The Pscale Graph Compare routines in Vista are facilitated by using the “Open Source” DosBox Dos Emulator which works fine for these routines. Read: About DosBox in the Pscale Help menu.

The Pscale Version 3.5 Update install and the 3.5 full install also contain Pscale 3.2 for Dos for the few Dos die-hards that still exist. Pscale 3.2 for Dos has been modified so that any print requests for scale data are written to a file that may be open by windows notepad and printed. Graphs may be saved to a .pcx graphics file and opened and printed with an image program. All Pscale for Dos printing ceased with the transition to Inkjet and USB printers. 

Running all aspects of Pscale for Dos in Vista via DosBox is not recommended as performance is much slower on the Auto Scale routines and Pscale Win is much better once you learn the graphics navigation. Using DosBox for the Pscale Win Graph Compare Dos subroutine works fine with very little speed penalty. The ability to run Pscale 3.2 for Dos via DosBox in Vista32 is really included to demonstrate that it can be done. However, Pscale 3.2 for Dos will run normally on all Windows versions up through version XP.

Pscale Version 3.6 (Windows Version Improvements)

This upgrade includes all Vista 32 bit upgrades of version 3.5 as well as the following features:

Tension Reports

The Tension report now includes a button named "By Section" that will allow you to enter a note range like 1 to 26 to get a total tension of strings on, let's say, the bass bridge only. This is helpful in more closely watching for tension increases and decreases by section. While tension increases may have implications on increased plate stress considerations, they also have implications on increased load on the soundboard. Increased load on the soundboard may be mitigated to some degree by how you set downbearing, but it is also important to be able to quantify net tension increases by section. Overall as well.

While on the Tension Subject: The main Pscale manual discusses tension increases with regard to overall tension increases and whether the plate can withstand up to 2% - 5% tension increase. The official "safe" positions is: Do not increase overall tension beyond the original scale's total tension. However, slight increases are sometimes impossible to avoid and no one has reported a broken plate since the inception of Pscale in 1989. Not yet anyway. At the same time, tension increases also have implications on soundboard load and soundboard design so we should keep this in mind while rescaling.

Auto Rescale Options

The Auto Bass Rescale defaults to target tensions in the middle of the Uni, Bi, and Tri tension guidlines. While this will work OK, it will yield fairly high jumps in tension in the transistions between Uni, Bi, and Tri note types. I have come to the conclusion during the past several years that I like the Auto Rescale Option button choice of "Increase Tension During Ascent" which allows the tension to be sculpted so that the top Uni is much closer to the combined tension of the 1st Bichord. Also the the top Bichord combined tension can be sculpted to be much closer to the combined next Trichord above. Remember that the default Pscale graph represents Tension and Inharmonicity of one string only. The net result of this type of sculpting will yield smoother tensions and on the default Pscale graph and you will have a Uni and Bi tension patterns that will rise from lower left to upper right. This results in smoother combined tension transitions.Please Note: The default auto scale would occasionally calculate and insert an uneven core pattern like .037, .037, .036, .037, .038, .039 (moving downward) .036 being the oddball that needs manual correction. The "Increase Tension During Ascent" option seems to have a slightly higher tendancy for up,down, up core wire patterns and should be checked and corrected.

Alternate Bass Conversions

A new option is presented here for a report that is to be included with an accurate string rubbing/pattern. It specifies Core, Outside Wrap Diameter in Decimal, and ATWM/BTWM Exposed Core lengths in mm. Most string winders will know how to derive an overall outside wrap diameter based on a given core wire. With a good rubbing/pattern, tell em what you want for core, OD, and exposed core and that's all they will need.

View Tension

The View menu Tension choice now asks for by (S)tring or by (N)ote. The (N)ote option plots combined tension of Bichords and Trichords. Until Version 3.6, the graph plotted by (S)tring and would not reflect combined Bi or Tri tension.

Edit Wrap Constants

There have been a few requests over the years to allow users to customize the values of the bass string wrapping materials constants. The default values are Copper .89, Iron .79, and Aluminum .27

The Pscale Setup menu naow has an Edit Wrap Constants selection so users can wrap their bass strings in 22 caret gold if so desired. I wonder wnat they would sound like.

Version Number anomaly corrected

The opening screen of Pscale displays the version number on the 3rd line of text. The "About Pscale" in Help now always displays the correct version number as well.

Change Pitch anomaly corrected

Previous versions of Pscale Win appear to have placed the frequency of note 87 in note 88 as
well. Any Pscale File that has been Pitch Adjusted will have the Frequency of  A3 in the DIWO
Column of note 88. If a value is in the cell, then Pitch Adjust should be run again to correct the
Frequency of note 88.

It should be noted that “Adjust Pitch” calculates the theoretical “Tempered” frequencies by starting at A440 and multiplying it by the twelfth root of 2 which is 1.0594631 (rounded to 7
decimal places) to obtain the next higher frequency and continues to note 88. It then returns
to A440 and divides it by 1.0594631 to obtain the next lower frequency and continues to note 1

Consequently there are slight variances in the frequency results. However, their effects on
INH, TEN, and BP are miniscule if any at all.
3520hz becomes 3519.995 (only one thousands of difference in Break %)
1760hz becomes 1759.998hz (no changes observed)
880hz becomes 879.999 (only one hundredths of difference in Tension)

Back Door to view all Data

There have been a few occasions over the years where access to all of the Pscale file data
could be helpful due to some random event that required a non visible field, or fields, to be
corrected. 

Be VERY CAREFUL using this feature as you could make an incorrect change that Pscale
could not calculate correctly. Of course, you can go back in and fix the error provided you
understand enough about the data columns that are not normally displayed in Pscale Win

To access the “Back Door”, you need to open the desired file and then, while in the main
Pscale screen, press F7. To exit this routine, Press the Esc key.

<End of 2.8 and up Info>



